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Happy February, Happy Valentine’s Day ! 

After a busy January, it is February al-
ready !  To judge by the “standing-room-
only” crowds at our January Membership 
Meetings, I should say that we are doing 
well.  The programs on SnagIt and Scan-

ning were most informative, and I had much positive 
feedback from Members.   Judy Taylour was great to lis-
ten to, she is so computer-savvy, and has a great sense of 
humor. 

Unfortunately, the SnagIt presentation could not be given 
by Lucy Breja as planned.  Her husband, former GSCC 
President Al Breija, passed away after knee replacement 
surgery unexpectedly on January 17.  Our sincere condo-
lences to Lucy and her daughter for their loss. Our hearts 
go out to them. 

We are looking forward to more interesting presenta-
tions, InfoWallet, Time Management, and Skype again.  
This time Jeannine Foote will be the presenter for Skype.  

As most of you know, I skype daily with relatives and 
friends in Europe. Don’t know what I would do without 
it. 

You tube 
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Our Club is doing well, 135 Members strong, and here to teach and help you. We also had 
eight (!) guests come to the last meeting, and 4 joined.  We must be doing something right.. 
Also, don’t hesitate to come with your questions and problems.  The second half of the pro-
gram is always set aside for that.  

Don’t forget to check the Newsletter at www.gscclub.org for upcoming classes, events, tips 
and tricks, and past programs.  Dan Leddy does a wonderful job to put it together every 
month. Thank you, Dan !  As a reminder, many of our past programs are posted on our FTP 
site under  www.gscclub.org for you to read any time again and review.  

Thank you, also, to everyone who volunteers to bring refreshments.  They are such a wel-
come treat halfway through the afternoon. 

See you February 9th ! 

Till then, 

Annemarie 

Members of GSCC mourn the pass-
ing Of Al Brejcha, former president of 
the Club and a good friend to all 
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GSCC Meeting Minutes 
January 12, 2011 

President Annemarie Hunt opened the meeting at 1:  pm  

President Hunt made the following announcements:  

� Called attention to Lucy’s Slideshow of the Christmas Party (showing & in the newsletter). 

� $124 was realized from the Silent Auction. 
� Thank you note from Barbara Denny received for help with the party. 
� State of the Club Report – The Club is doing “very well” with a healthy balance in the treasury. 
� Classes are scheduled & commencing for January and February 

� Currently 133 members with approximately half have paid for 2011. 
� Asked for any ideas for future programs: Bill Belcher suggested several sites including Restau-
rant.com and Groupon. 

� Jim Glass will give individual help outside the meeting after the break. 

� Today’s program on Snagit will be presented by Bill, and Ell. 

� President Hunt then turned the meeting over to Jim Glass.  
Program: Jim Glass, Program Director, http://gscclub.org/ Click on NEWSLETTER for scheduled programs. 

� Bill and Ell demonstrated the Snagit software program.  
� There was one full Snagit Version 10 to give away, a couple of T-shirts as well as eighty pens and 
eighty 30 Day Trial discs. 
President Hunt thanked Helga for all the delicious goodies she brought.  Alva, Jim Glass and Annette will 
bring treats to our next meeting.                      

Q and A: Bill Belcher and Ell Fullmer answered questions concerning various subjects including: 

� Primary Language issues, Auto Correct function, special characters. 

� Printers and Scanners. 
Education: Bill Belcher http://gscclub.org/ Click on CLASSES 

� January 22 Program will be on Scanning. 

� Other - The 50/50 was won by Jean Goff.  Winner of the Snagit software: Ann Stutsman. T-shirts: 
Ann, Jeannine Foote and Francine Walker. Pens and 30 day trial versions of Snagit were distributed. 

Asset Management: Glen Moore said there were a few things left from the Auction and should be picked up. 

Adjournment: President Hunt adjourned the meeting at 3:00 pm 

Submitted by:        Approved By: 

Secretary Ruthann Mayrose     President Annemarie Hunt  
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GSCC Meeting Minutes 
January 26, 2011 

President Annemarie Hunt opened the meeting at 1 pm  

President Hunt made the following announcements:  

� There are two Snagit 30 Day Trial discs still available.  

� Lucy Brejcha’s husband passed away Monday—Helga is circulating a card for all to sign. 
� Received from Winifred, a thank you note for help from the Computer Guys.  
� Asked again for Program ideas. 
� 

� President Hunt than turned the meeting over to Jim Glass  

President Hunt welcomed new members and visitors; there were 96 members and eight visitors at the 
meeting today. 

President Hunt then turned the meeting over to Program Director, Jim Glass  

Program: Jim Glass, Program Director, introduced Judy Taylour, President of the Santa Clarita Computer Club and Chair of the Southwest Com-
puter Conference.  Judy mentioned the upcoming Southwest Computer Conference 2011 (June 3, 4 & 5) and encouraged participation in the Digital 
Photo Contest. 

� Ms Taylour presented and demonstrated a very detailed and informational program on various scan-
ners including portable scanners, slide & negative scanners and digital pens.  Many of the products are avail-
able at IRISLink.com. 
� Next Program (2-9) - Info Wallet (portable personal information) 

� 2-23 - YouTube 

 

President Hunt thanked Alva Dominguez, Jim Glass & Annette for all the delicious goodies they brought.  Joanne and Rita will bring treats to our 
next meeting.    

Q and A: Ell Fullmer answered questions concerning various subjects including: 

� Moving files to new folders 

� Email address editing of contacts 
� Expanding USB ports 
 

Other - President Hunt encouraged members to join and support Partners of La Fetra Center. 
� Gift basket donated by the Foote’s was won by Connie Lang. 
� The 50/50 Drawing was won by Rich Janicki.  

Adjournment: President Hunt adjourned the meeting at 3:00 pm 

Submitted by:        Approved By: 

Secretary Ruthann Mayrose     President Annemarie Hunt  

 



February 2011 Page 5 

Computer Classes for 2011 

Note: All classes are held in the Elm Room of the LaFetra 
Center 

Minimum enrollment required – 5 students for each 
class offering 

  
  

March and April – Email and the Internet 
Do you want to surf the internet safely? Find what you are searching for quickly 
and efficiently? Want to print just part of a web page? Do some shopping? Get free 
stuff? Ever wonder why everyone is fussing about YouTube and Facebook? Find 
old friends? Make new ones? Make your email behave the way you think it 
should? Reduce the amount of spam in your inbox? Send and receive attachments 
without a hassle? Send email to a group of people all at once? Then this is the 8 
week class for you. 

When: Thursdays, March 10 through April 28 – 1:00 to 3:00 PM 
Class fee: $40.00 paid at least one week prior to start of class. 
Limited to 12 students 
 
 

March and April – The Digital Darkroom 
This eight week class is designed to help you get more out of your photo editing 
projects. Use the powerful editing capabilities in Adobe Photoshop Elements. Use 
layers and masking techniques to not just edit your pictures, but create digital mas-
terpieces. Create digital collages, montages, and even scrapbooks. 

When: Tuesdays, March 8 through April 26 – 1:00 to 3:00 PM 
Class fee: $40.00 paid at least one week prior to start of class. 
Limited to 12 students 

The student must have a Windows computer, a scanner and printer, and Adobe 
Photoshop Elements 6 or later software. The student should be familiar with basic 
photo editing techniques such as cropping, and color and lighting correction. 
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June and July – Basic Computer Skills 
If you are new to PCs or have been using a PC for a while but want to use it more 
effectively, then this 8 week course is for you. We will cover the fundamentals 
starting with how to turn the PC on and off, keyboard and mouse usage, installing 
and uninstalling applications, beginning word processing, as well as proper file 
management and maintenance. We will demystify some of those confusing boxes 
that pop up unexpectedly and throughout the course, we will use the language of 
computers so that you can understand and even speak a little geek. 

When: Thursdays, June 9 through July 28 – 1:00 to 3:00 PM 
Class fee: $40.00 paid at least one week prior to start of class. 
Limited to 12 students 

The student must have access to his/her own computer and be prepared to prac-
tice the techniques learned in this class for at least two hours each week. 

CERTIFICATION FOR THIS LATEST CPR TECHNIQUE IN NOT RE-
QUIRED.  

  

If you haven't seen this, you should.  If you have seen it, it won't hurt to see it again. 
This is a new CPR technique which is much simpler. 

This is a very important video regarding the latest CPR procedure.   

Please watch and forward to your friends and family if you haven't already done so.   

You never know, a life may be saved using this new procedure. 
 
http://tinyurl.com/2fx8r59 

   
(Submitted by club member Jim Glass 
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http://tinyurl.com/2fx8r59  

 Www.heartarizona.edu 

http://tinyurl.com/2fx8r59  
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Smart Computing Tips & Fun Facts   "Reprinted with permission from Smart Computing. Visit 
www.SmartComputing.com/Groups to learn what Smart Computing can do for you and your user group!" 

Stop Keyboard Jitters 
 

 

Trying to type on a rumbling train or plane is hard enough without your notebook's 
keyboard fighting you. Constant rumbling will cause you to press your keys too fast 
or too often, resulting in a long line of the wrong characters. The Windows FilterKeys 
feature will ignore brief or repeated keystrokes. To engage this feature, from the Win-
dows Control Panel, double-click “Accessibility Options,” and on the Keyboard tab, 
click the “Use FilterKeys” checkbox. Click Settings to tweak the feature's preferences 
to your liking 
 

Hot Battery Blues 
 

 

If you often run your notebook PC using the installed Li-ion battery, beware of ex-
tremely warm temperatures. These kinds of batteries don't tolerate heat very well 
and can leave you powerless if you're not careful. So, whenever possible, use your 
AC adapter in a hot environment. 

Don’t Strain To Read This 
  

Many of us spend way too much time squinting to read blurry words from a small de-
vice screen. This can lead to a number of health issues including headaches and 
blurred vision. However, technology manufacturers are trying to help out. Microsoft 
has developed a line of fonts, including Frutiger Linotype, specifically for hand-held 
screens. The font features open letters with plenty of white space between letters so 
it doesn’t look cramped. 

Don’t Bring In A Virus 
  

Although USB flash drives give you the ability to transport your files between work 
and home, you’ll want to make certain you don’t introduce a virus, which may have 
been on your home computer, onto your office network. If you have antivirus and    
antimalware software on your home PC, use the software to scan your USB flash 
drive before you take the flash drive to work 
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(Excel) 

Calculating Week-Ending Dates 
Do you keep track of information based on week-ending dates? Many businesses do, and therefore need a 
quick way to calculate the week-ending dates for the complete year. The dates could be easily calculated 
with a macro, but you can do it just as easily with formulas. 

There are two formulas you can use in order to calculate your week-ending dates. Let’s assume, for the sake 
of this example, that your year is stored in cell A1. You could then figure out the first Saturday of the year 
by using this formula in cell A3: 

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1)) 

This works because the WEEKDAY function returns a value of 1 (Sunday) through 7 (Saturday) for any 
date. If you subtract that value from 7, then you have a value of 6 (Sunday) through 0 (Saturday). When you 
add that value to the DATE value for January 1 of the year, you end up with the first Saturday of the year. 

If you prefer to have your weeks end on Fridays, then the formula needs to change a bit: 

=DATE(A1,1,1)+7-(WEEKDAY(DATE(A1,1,1)+1)( 

Finally, if you prefer to have your weeks end on Sundays, then the formula needs to be like this one: 

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1),2) 

This formula uses a parameter for the WEEKDAY function that calculates weekdays that range from 1 
(Monday) through 7 (Sunday). 

Once you have the first week-ending date for the year (in A3, remember?), then you can calculate the rest of 
the week-ending dates for the year. Place the following formula in cell A4: 

=IF(YEAR(A3+7)=$A$1,A3+7,"") 

This checks to see if one week past the previous date is still in the year. If it is, then the new date is returned. 
If it isn’t, then an empty string is returned. If you copy this formula from A4 down through A55, then you 
will have all the desired week-ending dates for the year. With the formulas in place, simply change the year 
in cell A1 to see how the dates change. 

The range A3:A55 provides room for 53 week-ending dates, which is possible for any given year. Because 
you used the IF statement in the formula in cells A4:A55, then the very last value (A55) will be blank if 
there were only 52 week-ending dates for the year. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free 
Microsoft Excel tips can be found online at http://excel.tips.net. 
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Word 2007 
Automatically Selecting Words 
When you are editing your document, there are many times that Word tries to guess what you are doing and 
then complete your task for you. This helpfulness can be aggravating at times. One such instance is when 
you are trying to use the mouse to select text from the middle of one word to the middle of another. When-
ever you click inside a word and then start dragging the mouse, Word assumes you want to make a selection. 
As soon as you move the mouse pointer outside the word, the program assumes you wanted to select the en-
tire first word in which you originally clicked. 

If you want to ensure that Word doesn’t make that assumption, you need to follow these steps to turn off the 
offending feature in Word 97 through Word 2003: 

1. Choose Options from the Tools menu. Word displays the Options dialog box. 
2. Make sure the Edit tab is selected. 

 
The Edit tab of the Options dialog box. 

3. Make sure the When Selecting, Automatically Select Entire Word check box is cleared. 
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Word 2007 
4. Click on OK. 

You can follow these steps if you are using Word 2007 or Word 2010: 

1. Display the Word Options dialog box. (In Word 2007 click the Office button, then choose Word 
Options. In Word 2010 display the File tab of the ribbon, then click Options.) 

2. Click Advanced at the left side of the screen. 

 

The Advanced area of the Word Options dialog box. 

3. In the Editing Options area, make sure the When Selecting, Automatically Select Entire Word 
check box is cleared. 

4. Click on OK. 
 
 
 
 
Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free 
Microsoft Word tips can be found online at http://word.tips.net. 
 



FEBRUARY 2011 Page 11 

 Discovering Windows 7 – Part 12  

By Neil Stahfest, Vice President, Tacoma Area PC User Group, Washington  

January 2011 issue, the Data Line 

NCStahfest (at) msn.com 

www.tapcug.org 

  

The Black Friday sales were too tempting this year, and I decided it was time to treat  

myself to a new laptop computer. When selecting a new computer you need to  

determine what your requirements are. I wanted something powerful enough to run  

my current software plus what I would probably need a year or two from now. I  

don’t consider myself to be a “gamer” but I do use some flight simulation software  

which has some pretty intensive graphics requirements. I decided to look for a  

computer with an Intel Core i7 processor plus with a lot of RAM and a good graphics 
card. I wanted a laptop computer so I could demonstrate software at S.I.G. meetings. 
After checking the Internet to find the best candidates that meet my requirements, I 
made my selection and placed an order. Getting a new computer is exciting and, 
while the experience is fresh in my mind, this is probably a good time to talk about 
setting up a new computer.  

 

If you bought your computer from one of the major manufacturers or a store, it  

probably arrived packed in a box with its accessories. When I opened my box and  

found a large folded sheet of paper labeled “START HERE.”  (Can anyone  

remember the last time they got a printed manual with a new computer?)  Unfolding  

it, on the front side I found two illustrated columns. One was labeled “QUICK  

SETUP” and the other, “AFTER SETUP.” Because I’ve learned the hard way, I  

took a moment to turn the paper over. Printed on the backside of the paper was  
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“GET MORE FROM YOUR PC” with pictures of my computer showing the top  

and sides with everything labeled. There was also a section showing how the  

TouchPad works. I’ve used a number of computers with TouchPads, and it seems  

like they are all a little different. If your computer comes with a TouchPad, I advise  

you to look this section over. You should at least find out how to turn the TouchPad  

on and off or you may wonder why it doesn’t work. ;-)   

  

Having studied (well at least glanced at) how the controls on my computer are laid  

out, I flipped the paper over to get back to “QUICK SETUP”. Following the illustrated 
instructions, I removed everything from the box, noting that I seemed to have every-
thing shown in the picture. I started by installing my laptop’s battery (as shown in an 
illustration). I connected external power, turned on the computer and prepared to fol-
low on-screen instructions. Nothing to it really. For a few minutes, the computer 
seemed to be doing internal things and small lights flashed. Then it asked me for my 
name, a password (which I had to enter twice) and I had to accept the license agree-
ment. A clock appeared, and I had to reset the computer’s clock to my local time 
zone and time. Then it was time to connect to the Internet!  

 

I could have used a cable to my Internet modem, but I elected to go wireless (that’s 
what I use most of the time anyway). The setup program included a “wizard” to help 
me here. The wizard wanted some information about my wireless network. A list of 
available local networks appeared (well, only mine really) and I clicked on it. It only 
took a few seconds for the wizard to figure out that I have an encrypted wireless net-
work and a security key code was needed. Since I’m so well organized (not really) it 
only took me a minute to find the book where I wrote it down when I created the key 
code. A dozen or two key strokes and the code was entered. Now it wanted to know 
what kind of network I was using. Was it a Home network, a Public network or Work 
network?   

They have different security settings. I selected “Home.”  
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 Next, the installer wanted to know about my “Homegroup.” The Homegroup is a 
new feature of Windows 7. It is basically a private network that allows secure access 
to selected files and printers on the Homegroup network without a complicated proc-
ess of configuring the computer with various network settings. In a Homegroup net-
work, each Homegroup member is a computer not a specific user.  

In other words, if I add my laptop computer to my Homegroup, which includes a 
desktop computer running Windows 7, anyone using my laptop will have the same 
access to files and printers attached to my desktop computer.  

In a home setting, this can make it very easy to share files and printers between 
computers. I can print documents and pictures from my laptop computer on the laser 
printer attached to my desktop computer.  

 

So after asking me if I wanted to use a Homegroup, the installer program asked me 
to select what I wanted to share including pictures, music, videos, documents and 
printers. I selected all of them. Then it asked for my Workgroup password. This 
password encrypts the information passing between the computers on the your 
Homegroup so, even if you are using a wireless network connection, if someone in 
your neighborhood were to intercept the information passing between your com-
puters, they wouldn’t be able to read the information.  

  

Duh, I didn’t have that written down. Luckily, the installer program told me how to 
find it on my other Homegroup computer. All I needed to do was to go to my other 
computer, click on the Windows “Start” button, type “Homegroup” in the search box 
and, when the Homegroup window appeared, locate where it says “View or print the 
Homegroup password” and click on it. I decided to print it.  

 

After entering the password on my laptop computer, I placed the printout in my book 
with the Internet  security key code for future reference.  
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At this point the computer restarted, using Windows 7. Since this was the first time 
Windows 7 was running on this computer, it gave me an opportunity to register the 
computer with the manufacturer and then gave me a tour of Windows 7.  After the 
tour, now that my new computer was working, I make a system image backup (as 
described in this column in “Discovering Windows – Part 3”). Now all I have to do is 
figure out what programs I want to install on my new computer!  :^)  

  

Setting up a new computer will probably never be as easy as setting up a new bread 
toaster but, as you can see from the above description, it’s not very difficult. I could 
have saved a few steps if I had plugged the computer directly into my hi-speed mo-
dem with a cable before I started the installation. That would have avoided the need 
to setup the wireless connection, but I wanted my computer to be portable.  

If I only had one computer, then I wouldn’t have needed to configure a Homegroup, 
but even that was no real challenge. If you set up a Homegroup, just remember that 
all the computers connected to the same Homegroup must use the same Home-
group password.  

 

So to all of you who got a new computer over the holidays, or in the January sales, 
HAPPY COMPUTING.      **** 

The Computer Guys, Bill Belcher & Ell Fullmer, will be meeting on the  

SECOND Thursday of the month:  

 Feb 10, Mar 10, April 14 

9:00 a.m. to 12 noon — Second Floor — La Fetra Center 
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 Buying and Selling on eBay (Part 1 of 5) 

Submitted by Gini Pedersen, Instructor, FREE Internet and Computer Classes, San 
Diego Continuing Education; Honorary Lifetime Member, Seniors Computer Group, 
for her outstanding work in the community 

http://www.iteachyou.com        gpederse (at) sdccd.edu 

What is eBay? 

eBay is the largest and most popular auction site on the Internet. Their main service 
is to match up buyers with sellers anywhere in the world.  Although the buyer doesn't 
pay anything to eBay to bid or win an auction, the seller does pay one or more fees. 
Fees vary, depending on what is being offered and the features included in the list-
ing. 

 

Registering on eBay  

Following are guidelines for setting up an eBay account: 

1. Go to http://www.ebay.com/ 

2. Click Register link. 

3. Complete all registration fields. 

 

Viewing an Item on eBay 

Following are guidelines for viewing auction items at eBay: 

1. Go to http://www.ebay.com/ 
2. Click “Sign In” link and log on to your eBay account. 

 Note:  Although you can view items on eBay without clicking the Sign In link, you 
cannot bid  on items without first logging on. 
3. Type a search keyword(s) in the field under the eBay logo at the top of the eBay 
window and choose a category to the right, if desired. For example, type keywords 
Canon Camera and choose “Cameras and Photo” category. You can further narrow 
your search by choosing one or more options in the “Refine Search” sidebar on the 
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left. For example, Digital Cameras. Continue narrowing your search until you see a 
reasonable number in orange to the right of the Refine Search sidebar. 

4. Click the down-facing arrow to the right of the “Sort By field” to organize the re-
sults in desired order. 

 Note: The Sort By field is on the right side of the screen, just above the first item 
listed. 
5. Click on the blue, underlined wording (Title) to the right of the image to see a 
specific item. 
6. Scroll down to read details about this listing. The top portion is part of a 

"template" provided by eBay that contains the most important information about 
the listing, and below that is the description written by the seller. 

Bidding on an Item on eBay 

1. Sign in with your User ID and Password. 

2. Locate the item you want to bid on. 

3. Bookmark the item so you can review its status later. 

4. Read all information about the auction item. 

5. Scroll to the top and type in the maximum bid in the “Your Max Bid field” - the 
maximum you would be willing to spend--knowing that bidding will reach this 
maximum only if another bid causes the amount to increase. 

6. Click “Place Bid” and then “Confirm Bid” on the next screen. 

7. You will see either the minimum bid (“Starts At” amount) submitted in your name 
(if you are the first bidder) or else the previous bid will be increased by the Bid In-
crement amount.  

Note: Click Bid History if you want to see the details about all bids so far. For 
most items your User ID will be replaced with one that looks like the following: 
x***x which protects the identity of the bidder. 

1. Check back periodically (if desired) to see how bidding is progressing on the item. 

                                                                 **** 
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 Buying and Selling on eBay (Part 2 of 5) 

Submitted by Gini Pedersen, Instructor, FREE Internet and Computer Classes, San 
Diego Continuing Education; Honorary Lifetime Member, Seniors Computer Group, 
for her outstanding work in the community 

http://www.iteachyou.com 

gpederse (at) sdccd.edu 

Guidelines for Safe and Successful Buying on eBay 

Guideline #1: Be cautious about bidding on a high-priced item from a seller with a 
rating in the mid or low 90% range. Also check the number next to the seller's User 
ID since this indicates the number of feedbacks that the percentage amount relates 
to. 

People who repeatedly sell merchandise on eBay can’t afford to have a negative 
feedback rating, and they’ll go out of their way to make sure the customer is satis-
fied. Check the seller's profile and use this information to evaluate this seller. 

 Guideline #2: Escrow Service 

For purchases over $500 consider using an escrow service such as eBay's at http://
www.escrow.com. Doing so will ensure that you get satisfaction before your funds 
are released to the seller. The fee charged for their service is worth the peace of 
mind that you’ll get by knowing your transaction will be secure. Of course, there are 
other escrow services available, but be cautious when selecting one. Never let the 
seller select one. 

 Guideline #3: Understand the process 

Get out there and learn all you can. Read the eBay guidelines, check out the Safe-
Harbor policies, look at other auctions by the same seller and make sure everything 
appears to be on the level. Information is power, and the only way you can hope to 
come out ahead is to know everything there is to know.  

 Guideline #4: Sales outside the country 

Never wire money out of the country. This is usually a bad idea; you have little 
chance of getting the money back. 

 Guideline #5: Requests to update your shopping or payment account 
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If you receive an email message asking you to update your shopping or payment ac-
count, don't click its links or buttons. Just delete the message. Sites like eBay, Pay-
Pal, etc. never send emails asking for updated information. Such bogus messages 
are referred to as Phishing. 

 Guideline #6: Social Security Number 

Never give your SSN to anyone who doesn't have a valid reason for needing it. 

 Guideline #7: Credit Card Info 
Never give your credit card information in an email message. Only provide it on se-
cure websites. You should see https:// (not just http://) at the start of the address on 
screens where credit card information is entered. 

 

When you enter a "maximum" (also called proxy) bid for an item, you are indicating 
the highest amount you might be willing to spend for this item. You will pay this maxi-
mum amount ONLY if another bidder(s) bid against you, but don't exceed the maxi-
mum amount you entered. 

 

Although no one actually sees what you enter as a maximum bid, you have revealed 
your interest in this item which occasionally draws more interest from others. 

To allow the flexibility of a maximum bid -- and NOT reveal your interest in this item 
until a few seconds before the end of the auction, you can use an automated 
"sniping" service. I use BidRobot.com (http://www.bidrobot.com) which is very inex-
pensive and reliable.  Or you can enter a manual bid during the last several seconds 
to do this yourself. Manual snipers often get beat out by automated sniping services. 

 

It is important to use ONLY a sniping service that you feel you can trust, since you 
will be providing them with your eBay user ID and password, so they can bid on your 
behalf.  I have used BidRobot for over 2 years. Others I've heard of (but not used) 
include AuctionTamer (http://www.auctiontamer.com) and Auction Sentry (http://
www.auction-sentry.com).   **** 
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  Ask Mr. Modem! – February 2011       
www.MrModem.com     
 
Review Windows Updates  
 
Q. I’ve installed a number of Windows updates, but I can’t remember which ones I 
have installed. Is there somewhere I can check to determine which updates have been 
installed? 
 
A.  If you’re using Windows XP, go to your Control Panel and click Add/Remove Programs. 
Place a check mark in the box labeled “Show Updates.” Any installed updates, and their re-
spective date(s) of installation, will be displayed for your review. If you’re using Vista, go to 
Control Panel > Programs & Features. Under “Tasks” on the left, select “View Installed Up-
dates.” Windows 7 users, click Start and in the Search field, type “View installed updates” to 
navigate to that area. 
 
 
Q.  I am trying to retrieve some information from a Web site and have been informed 
that in order to do this, my browser (Firefox) must have pop-up blocking enabled. I 
don't know how to do this. Can you help, Mr. M? 
 
A.  The message you received probably asks you to disable (not enable) pop-up blocking in 
order to allow a pop-up required by the site in question. Either way, click Tools > Options > 
Content tab.  
 
Rather than remove the check mark beside “Block pop-up windows” which would then al-
low pop-ups to appear on any and all Web sites, click the Exceptions button and add an ex-
ception by typing in the Web site address of the site (or sites) from which you do want to 
permit pop-ups.  
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Q.  When I receive photos by email, they are very large. Too large. Is there a way 
that the photos can be made smaller? Thanks in advance for your help, Mr. M. 
 
A. The problem with super-large photos usually lies with the senders of those photos. It's 
best to take low-resolution photos if you're planning to send them by email. Most digital 
cameras have a setting for that, but instead, many people send higher resolution photos 
that are great for making prints, but often result in huge files or displayed photos. 
 
You can resize the photos yourself, though you might want to politely suggest that the 
sender actually open the manual that came with his or her camera and learn how to take 
low-resolution photos, or determine what settings might exist for that specific purpose. 
Some cameras have an “Email” setting which produces low-resolution photos, perfect for 
emailing. 
 
If you are the recipient of a super-large photo, Shrink Pictures (www.shrinkpictures.com) 
is a Web-based service that enables you to reduce the size of digital photos. No software is 
required, and the service is free. As an alternative, Resize2mail.com 
(www.resize2mail.com) is also free. Senders of photos would be well advised to use ei-
ther of these sites before sending photos. 
 
My suggestion for anybody who wants to share photos with others is to simply use one of 
the free, online photo albums such as Snapfish (www.snapfish.com), Shutterfly 
(www.shutterfly.com), PhotoBucket (www.photobucket.com), or Picasa (http://
picasa.google.com). Once uploaded, you can simply send the Web address to others, who 
can then view  your photos online, rather than having to fuss with downloading and resiz-
ing. Photos can also be posted on one's Facebook page or other similar “social media” 
site. 
 
 
Q.  How can I convert ALL CAPS to an Initial Cap and the rest of the letters in 
lower case when working on a Word document? 
 
A.  In Word, SHIFT + F3 is the case toggle, so just select (highlight) the words you want 
to change and press SHIFT + F3 to switch between ALL UPPER, all lower, or Initial 
Capitalization, also known in the biz as “nish caps.” 
 



FEBRUARY 2011 Page 21 

Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month  
 
10MinuteMail.com 
A disposable email address can help keep you off spammers’ lists. By providing this type 
of address when shopping online, for example, you can still receive a purchase confirma-
tion, but avoid subsequent spam or follow-up solicitations. 10MinuteMail, as its name 
suggests, exists for 10 minutes. It's free, so just go to the site and you will be assigned an 
email address. Any email sent to this address will appear on the 10MinuteMail Web page 
where you can read it, click on links, and even reply, but the email address will self-
destruct after 10 minutes, vanishing without a trace. You can, however, click to obtain an 
additional 10 minutes, which is kind of like a snooze alarm, but without the annoyance.. 
http://10minutemail.com 
 
Paper-Cut Sculptures 
It doesn’t require a lot of expensive material to create great art, just an incredible amount 
of imagination and talent. Check out the work of sculptor Peter Callesen, who uses single 
sheets of paper to create astonishingly intricate "Paper-cut Sculptures.” (After years of in-
tensive practice and significant blood loss, I am proud to say that I have mastered the 
“paper-cut” portion of his technique.) 
http://oddee.com/item_89460.aspx  
 
Gas Prices 
Now that gasoline prices are on the way up again, there are a number of sites that can help 
you track down the lowest prices in your area or while on the road, if you're traveling. 
Several of the more popular gas-price monitoring sites include: GasBuddy.com, 
MapQuest Gas Prices (http://gasprices.mapquest.com), GasPriceWatch.com, and FuelE-
conomy.gov. 
 
 

For plain-English answers to your questions by email, plus great computing tips, 
subscribe to Mr. Modem’s award-winning WEEKLY newsletter. Subscribe using 
Promo Code 0847 and receive a free month (four weekly issues!) with your six-
month subscription. To view a sample issue or subscribe, visit www.MrModem.com.   
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>**HUGE California Traffic Tickets Fines Effective 01/06/2011** 
> 
>Please be extremely careful in your driving and car registration &  
>insurance matters. State of California is broke and they are trying  
>hard to squeeze all of us hard to collect money. 
> 
>Effective immediately, if you do not stop at the red light, be ready  
>to pay $436 in fines or if you pass a school bus with flashing red  
>signals, you will be charged $616. The state of California is going  
>for blood, so be extra careful in driving, You cannot afford messing  
>with them. I have been hearing that Highway Patrols are under  
>pressure to issue a lot more tickets than last year with at least  
>30% increase in fines over 2009, so beware of radar guns, highway  
>and traffic cameras installed everywhere and the tougher enforcement  
>of parking rules. 
> 
>Just for your info, the next time you park in the handicapped zone,  
>even for a minute, you will be looking at almost $ 1000 in parking  
>tickets , so it'd better be worth it. 
> 
>California needs money, so pay close attention to the rules of the road! 
> 
>*Traffic Ticket Fines** (Effective 01/06/2011) * 
> 
>VC 12814.6 $214 Failure to obey license provisions. 
> 
>VC 14600(A) $214 Failure to notify DMV of address change within 10 days 
> 
>Note: The fine may be reduced with valid proof of correction. 
> 
>VC 16028(A) $796 Failure to provide evidence of financial  
>responsibility (insurance) 
>>Note: This fine may be reduced with proof of insurance on or after  
>the violation date. 
> 
>VC 21453(A) $436 Failure to stop at a red signal. 
> 
>VC 22349 $214 Unsafe speed, 1 to 15 miles over the limit. 
> 
>VC 22350 $328 Unsafe speed, 16 to 25 miles over the limit. 
> 
>VC 22450 $214 Failure to stop at a stop sign. 
> 
>VC 22454(A) $616 Passing a school bus with flashing red signals. 
> 
>VC 23123(A) $148 *Driving while using a wireless phone not hands  
>free, first offense *. 
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>>VC 23123(B) $256 Driving while using a wireless phone not hands  
>free, each subsequent offense. 
> 
>VC 23123.5 $148 Driving while using a wireless device to send, read  
>or write text. 
> 
>VC 23124 $148 Minor driving while using a wireless phone. 
> 
>VC 22500 $976 Parking in a bus loading area. 
> 
>VC 22507(A) $976 Violation of disabled parking provisions, first offense. 
> 
>VC 22507(B) $1876 Violation of disabled parking provisions, second offense. 
> 
>VC 26708 $178 Unlawful material on vehicle windows. 
> 
>VC 27150 $178 Adequate muffler required. 
> 
>VC 27315 $148 Mandatory use of seat belts. 
> 
>VC 27360 $436 Mandatory use of passenger child restraints. 
> 
>Note: This fine may be reduced by completing a court authorized  
>child seat diversion program . 
> 
>VC 27400 $178 Headsets or Earplugs covering both ears. 
> 
>VC 27803 $178 Violation of motorcycle safety helmet requirements. 
> 
>VC 34506 $616 Commercial Driver - Log book violation. 
> 
>VC 4000 $256 No evidence of current registration. 
> 
>Note: The fine may be reduced with valid proof of correction. 
> 
>VC 4159 $178 Notify DMV of change of address within 10 days. 
> 
>Note: The fine may be reduced with valid proof of correction. 
> 
>VC 5200 $178 Proper display of license plates. 
> 
>Note: The fine may be reduced with valid proof of correction. 
> 
>VC 9400 $178 Commercial weight fees due. 
> 
>Note: The fine may be reduced with valid proof of correction Look  
>out for the money grabbers in Sacramento but don't blame the cops.  
>They don't set the fines or collect them! 
> 

(Submitted by club member Helga Djordjevic) 
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DO YOU HAVE A QUESTION FOR OUR TECH GUYS, BILL BELCHER & ELL FULMER? 

Fill Out the Form Below & Bring it to the Meeting 

 

Name: ______________________________________________________________________________________________ 

 

Cptr Operating System      Windows 98   ___  Windows XP   ___  Windows Vista  ____ Windows 7 ______ Mac___ Other____ 

 

Question:_________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

 



 

333 East Foothill Blvd. 
Glendora, CA 91741  
Telephone: (626) 914-8235 

All opinions herein are those of the individual authors only, and do not necessarily reflect the opinion of the GSCC. The GSCC does 
not endorse, rate or otherwise officially comment on either products, services or vendors. Readers are cautioned to rely on the opin-
ions presented at their own risk and discretion.  

The GSCC, its editorial staff, and its contributors assume no liability for any damage arising out of the reliance upon any published 
article. 

Articles are compiled without verification of accuracy or applicability of accuracy or applicability of any article. 

We’re On The Web  
Webmaster:  
Ell Fullmer 

www.gscclub.org 
Email:  

gscc(at)gscclub.org 

Elected Officers 

Committees & Chairpersons 

Have a New  

Email Address?  

Please Notify Membership 
Chair: Jeannine Foote  

jeanninefoote(at)
yahoo.com 

Thank you to the following mem-
bers for help in this   

 month’s Newsletter: 

 Jim Glass 

 Helga Djordjevic 

  

  

 

Program Director            Jim Glass  jglass1001(at)aol.com 

Asset Management       Glen Moore mooretours(at)earthlink.net 

Membership  Chair      Jeannine Foote  jeanninefoote(at)yahoo.com 

Public Relations        Frances Madrigal frannrm(at)roadrunner.com 

Nominations                

Programs Chair            Jim Glass jglass1001(at)aol.com 

Webmaster                     Ell Fullmer pakratt(at)gmail.com 

Education                       Bill Belcher billbelcher(at)gmail.com 

Newsletter Editor     Dan Leddy ranchitoave(at)yahoo.com 

Set-Up Chair                   Bill Hart Bobbibill(at)peoplepc.com 

Please submit Newsletter Arti-
cles by the last Friday of the 

Month.  

Type GSCC in Subject Line. 

Email to Dan Leddy 

ranchitoave(at)yahoo.com 

President                Annemarie Hunt ajhunt1447(at)aol.com 

Vice President Connie Lang connielang(at)verizon.net 

Secretary Ruthann Mayrose Ruthannmeister(at)gmail.com 

Treasurer                Rose Marie Diem catscobwebs(a)charter.net 

Tech Advisor  Ell Fullmer pakratt(at)gmail.com 

Past President—Annemarie Hunt Ajhunt1447(at)aol.com 


